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Introduction

JPollution is a pair of Java programs with which you can create topographic maps of land
contaminated by pollution from various sources, and simulate sampling runs to measure the
pollution. The idea is not to teach specifics of pollution propagation (the pollution distribution models were selected for computational ease, not accuracy), but different sampling
strategies and their advantages and disadvantages.

1.1

Getting JPollution

The programs making up the JPollution package are written in Java. You will require a
Java Runtime Environment (JRE, also called a Java Virtual Machine, or JVM) to run the
programs. See section 1.1.2 for details.
The package and documentation are both available for download for free from the project
website, www.ibises.org.uk/JPollution. Choose the appropriate download for your Java version (section 1.1.2) and download the zip file. This will include the two .jar files that are the
programs, two .pdf files1 of documentation, and a licence document and copyright notice.
1.1.1

Licensing and distribution

This document is public domain. You may copy, modify, or distribute (possibly modified)
versions to your heart’s content. JPollution is released under the GNU General Public
Licence (GPL).
JPollution is free software; you can redistribute it and/or modify it under
the terms of the GNU General Public License as published by the Free Software
Foundation; either version 2 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General
Public License for more details.
1

Portable Document Format (PDF) is a format developed by Adobe Inc. Free readers are available for
download from their website, www.adobe.com.
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You should have received a copy of the GNU General Public License along
with this program; if not, write to the Free Software Foundation, Inc., 51 Franklin
St, Fifth Floor, Boston, MA 02110-1301 USA
If all you want to do is use JPollution, then don’t worry. You can download the programs,
install and copy them freely. You can give copies to students, colleagues or friends. However,
distributed copies are also subject to the GPL, which means that you must provide either
a copy of the source code, or the information that the source code can be downloaded
from the project website, www.ibises.org.uk/JPollution. The author hereby notifies you
that he will not consider the installation of copies of PollutionSampler.jar on machines in
an institution’s computer lab for use in a scheduled class to be distribution, whatever the
legality may be. However, giving copies to students for use at home (even on loaned laptops)
does count as distribution; also please see the next paragraph. Please direct queries to
pollution@ibises.org.uk.
One condition of the GPL is that the source code to programs licenced under it must
be made available to users. The source code can be downloaded from the project website,
www.ibises.org.uk/JPollution. The source code may be modified, and modified versions of
the programs may be distributed; however these must also be licenced under the GPL. Note
that the specific exception to the definition of distribution described in the previous paragraph may not apply to modified versions of the program. The author of the modifications
retains copyright over the modifications, and may choose not to make such an exception.
Versions of the software downloaded from the project website, www.ibises.org.uk/JPollution
are guaranteed to include this exception.
1.1.2

Installing Java

JPollution is written in Java. The advantage to this is that it will work on any operating
system (Windows, Unix, Mac OSX, etc.) for which Java has been written. The disadvantage
is that you must install a Java Runtime Environment (JRE, sometimes called a Java Virtual
Machine, or JVM) before you can run the programs.
You may already have a JRE installed. The easiest way to test is to download JVersion
from the project website, www.ibises.org.uk/JPollution, and double click on the icon of the
downloaded file. If it runs, a window will appear, containing the words “Java version: ” and
a number. If so, note down the number, and proceed to the next section.
If the program does not run, you either have no JRE installed or it is set up incorrectly.
You will need Administrator access to your machine to install a JRE; you may need to
contact your System Administrator.
Several vendors supply JREs. The official version is available for download without charge
from Sun Microsystem’s website, java.sun.com. Download and install the version appropriate
for your platform. You do not need either documentation or the Software Development Kit
(SDK), although you may also download these. Follow the instructions on the website to
install the JRE.
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1.1.3

Installing JPollution

You need a Java Runtime Environment to be able to run the JPollution programs. See
section 1.1.2 for instructions on how to install a JRE, or how to determine the version of the
JRE you have installed.
JPollution requires no installation. Simply download the appropriate zip file and unzip
it to a folder. The zip file contains the following:
1. PollutionCreator.jar – the program for creating polluted maps
2. PollutionSampler.jar – the program for sampling the maps
3. InstructorManual.pdf – this manual
4. StudentManual.pdf – a one-page introduction to PollutionSampler, intended for use
by students
5. gpl.txt – the GNU General Public Licence, under which this package is distributed
If you have a Java Runtime Environment installed, you should be able to run the two
programs immediately. Under Windows and Mac OSX, just double click on their icons. If
you are running from a command line, change to the directory in which the .jar files reside,
and use ‘java -jar PollutionCreator.jar’ to run. If the programs won’t run, you may not have
a JRE installed. See the previous section.

1.2

Bugs

It is very rare for a program to be entirely free of errors, or bugs. JPollution probably has
some — you can help remove them by reporting any you encounter.
1.2.1

Known bugs

There are no known bugs in JPollution.
1.2.2

Reporting bugs

Please report bugs to pollution@ibises.org.uk. Any bug report is better than nothing, but
the more information it contains the better. The better the report, the more likely the bug
is to get fixed. Information that is helpful in diagnosing bugs is:
• Your operating system
• Your Java Runtime Environment version and manufacturer
• Which version of JPollution you are using (see the ‘About’ option in the ‘Help’ menu)
It is also useful if you can provide a copy of the map you were using or editing when the
problem occurs. If you can determine a sequence of actions that causes the bug to manifest,
this is also useful.
3

1.2.3

Feature requests

If JPollution doesn’t do something you’d like it to, please email a suggestion to pollution@ibises.org.uk. I don’t guarantee that I’ll implement your idea, but I can’t if you don’t
ask for it.
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Running PollutionCreator

When you want to create an exercise for your students, you first need to create a map.
PollutionCreator is the program that does this. Under Windows and Mac OSX, as well as
many UNIX graphical environments you can simply double click the PollutionCreator.jar
icon. From a command line, change to the directory containing the .jar file and type ‘java
-jar PollutionCreator.jar’. A window titled “Pollution Creator” should appear after a few
seconds.

2.1

Creating a map

The PollutionCreator window is divided into two regions, the Control Panel on the left and
the Map Display on the right.
2.1.1

Points

The core of creating a map is putting points into the Map Display. To put a point on to the
map, click somewhere on the Map Display and one will appear. A point can represent a hill
(shown as a yellow cross), a visible source of pollution (a light blue box) or a hidden source
of pollution (a dark blue box). You can decide which type of point to create using the “New
point type” drop-down box in the Control Panel.
A point can be selected once it has been created, just by clicking on it. A purple circle
appears around the selected point. Data describing the selected point appears in the Control
Panel. The selected point can be deleted by clicking the “Delete selected” button in the
Control Panel while a point is selected. A point can be moved by dragging it around the
Map Display.
When a point is selected, data describing it appears in the Control Panel. This data can
be edited to change the properties of the point. The point type can be changed using the
“Current point type” drop-down box. Its position can be altered using the “x” and “y” text
boxes. The origin of coordinates is in the top left of the screen, and the length of a side is
shown in the “Scale” text box. The other point settings do different things depending on
the point type.
• Hill: The boxes below the “y” control are “Hill height” and “Hill radius”, and the “Air
strength”, “Air inner radius” and “Air outer radius” boxes are greyed out and inoperative. A hill point is the center of a circular Lorentzian-profiled hill (see section 2.4),
whose height in metres is set using the “Hill height” box. The “Hill radius” box sets
the radius at which the hill height is half its maximum value. If either of the height
or radius settings are zero, the hill does not contribute to the terrain. The displayed
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terrain is the sum of all the hill points. The displayed contour lines are at ten-metre
intervals.
• Source: The boxes below the “y” control are “Ground strength” and “Ground radius”,
and the “Air strength”, “Air inner radius” and “Air outer radius” boxes are active. If
the source is a Visible source it will appear on the map in PollutionSampler; if it is
a Hidden source it does not appear on the map. The pollution contour lines (which
appear at ten parts-per-million intervals) will not appear in either case. Pollution
sources can produce two types of pollution
– Ground water pollution: A pollution source of this type is at the center of a
circular Lorentzian-profiled pollution field (see section 2.4). The strength of the
pollution (in parts-per-million) at the source is set using the “Ground strength”
box. The radius in kilometres at which the pollution drops to half its maximum
value is set using the “Ground radius” box.
– Airborne pollution: Airborne pollution is usually produced by a chimney. Its
strength is, therefore, zero at the source, rises to a maximum at a certain radius, and decays away again. The strength of the pollution at the maximum,
in parts-per-million, is controlled using the “Air strength” box. The radius of
the maximum and the decay radius are controlled by the “Air inner radius” and
“Air outer radius” boxes. The relationships are slightly complex; please see section 2.4 for details. The distribution also depends on the wind speed and direction
(section 2.1.2).
2.1.2

Map settings

The Control Panel has some controls that affect the whole map and the sampling runs.
The uppermost box in the Control Panel is labelled “Pollution at cursor”, and displays the
pollution in parts-per-million that a user of PollutionSampler would see if they sampled the
pollution where the mouse pointer currently is. It is more accurate than the contour lines
(see section 2.4 for details).
The second box is labelled “Map title”. You can enter a title here, and it will appear in
the title bar of both PollutionCreator and PollutionSampler when the map is loaded.
The third and fourth boxes are titled “Wind speed” and “Wind direction” respectively.
They control the speed and direction of the prevailing wind on the map, which affects the
distribution of airborne pollution. The speed is specified in kilometres per hour, and the
direction as a bearing in degrees. North is aligned vertically upwards on the map, and the
wind blows towards the bearing specified.
The fifth box is titled “Scale”, and is used to specify the lengths of the sides of the map
in kilometres.
The sixth box is titled “Samples allowed”. When the map is loaded in PollutionSampler,
the user will only be allowed to sample the pollution a certain number of times. That number
is specified using this control.
Below the “Samples allowed” box is a tick-box titled “Results visible on click”. If this
box is selected, the pollution strength is visible in PollutionSampler as soon as a sample is
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taken. If it is not set, the results are only visible once all samples have been taken. This
allows you to simulate the condition in which samples can be analysed in the field, or in
which samples must be returned to the lab for analysis.

2.2

Saving, loading and exporting maps

Once you have created a map, you can save it using the “Save map” option in the “File”
menu. The map is then ready to load in PollutionSampler, or it can be loaded for further
editing by using the “Load map” option in the “File” menu.
You may also want to provide printed copies of the maps for your students. This is most
easily done using the “Export as BMP (no pollution)” option in the “File” menu. This
produces a copy of the map in bitmap format, including any visible sources and terrain
contour lines but not pollution contour lines, invisible sources or hilltop markers. Bitmap
is a standard format that can be displayed and printed by most image viewing and editing
programs, and imported into most word processors. If you want a version of the map
including the pollution contour lines then use the “Export as BMP (pollution)” option.

2.3

Worked example

This section takes you through the steps to create a map with pollution ready for use in
a sampling exercise. This map is used in the “Suggested exercise” (section 4), and can be
downloaded from the project website, www.ibises.org.uk/JPollution.
Start PollutionCreator (see section 2). The Map Display should be blank.
2.3.1

Creating topography

The first step is to create some hills. These (currently) have no effect on the pollution
distribution, but provide some character to the area.
1. Make sure that the “New point type” box is set to ‘Hill’.
2. Click on the Map Display near the upper right corner. A yellow cross with a purple
circle will appear where you click, numbers will appear in the “x” and “y” boxes, and
zeros will appear in the “Hill height” and “Hill radius” boxes.
3. Click in the “x” box, delete the numbers and enter the value ‘0.85’ and press the Enter
key. The point will move to the upper left corner.
4. Press the Tab key and the cursor should jump to the “y” box (this won’t work if you
have an old JRE or if you’ve clicked somewhere else since you pressed Enter. If it
doesn’t work, click in the “y” box instead). Delete the numbers and enter the value
‘3.92’ and press the Enter key. The point will move to the lower left corner.
5. Press Tab again (or click) to select the “Hill height” box. Delete the number and enter
the value ‘75’.
6. Select the “Hill radius” box, delete the number, and enter the value ‘0.5’. Seven green
contour lines, roughly circular, will appear around the yellow cross.
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7. Click on the map once more. The purple circle disappears from around the first point,
and appears around the new one.
8. Move the mouse pointer so that it is within the purple circle, and drag (press and
hold the left mouse button while moving the mouse) the point until the “x” and “y”
values read approximately ‘0.7’ and ‘3’ respectively. Edit the numbers to make them
read exactly ‘0.7’ and ‘3’. Set the “Hill height” and “Hill radius” to ‘65’ and ‘0.5’
respectively.
9. Create a third point and set “x”, “y”, “Hill height” and “Hill radius” to ‘1.7’, ‘4’, ‘50’
and ‘0.25’, respectively. The result should be an egg shaped hill, with three peaks in
an L shape.
2.3.2

Creating pollution

The most important part of the map creation is creating the pollution sources. There are
two types of sources; visible and hidden. We will create one of each.
1. Click on the map, and a yellow cross appears, centred in a purple circle. Change
the “Current point type” to ‘Visible source’, and the yellow cross changes to a light
blue square. “Hill height” and “Hill radius” become “Ground strength” and “Ground
radius”. The three other boxes, “Air strength”, “Air inner radius”, and “Air outer
radius” become active with value zero.
2. Move the square (using the mouse or by editing “x” and “y”) to (4.6,4.6). Change
“Air strength” to ‘20’, “Air inner radius” to ‘1’ and “Air outer radius” to ‘1.25’. Red
contour lines will appear when the third number is typed.
3. Move the mouse around in the Map Display. As the mouse moves, numbers appear
in the “Pollution at cursor” box at the top of the Control Panel. Notice that the
pollution strength is very low at the source, rises to a maximum of about twenty parts
per million just outside the first contour line, then decays away again.
4. Set the “New point type” to ‘Hidden source’. Click on the map, and a dark blue square
will appear, surrounded by a purple circle.
5. Set “x”, “y”, “Ground strength”, and “Ground radius” to ‘0.72’, ‘1.8’, ‘50’, and ‘0.1’
respectively. More red contour lines will appear as the last number is entered. Note
that the contour lines are brighter for higher values.
2.3.3

Setting the map parameters

The map has certain properties that can be set.
1. The distribution of airborne pollution is affected by the prevailing winds in the area.
Set the “Wind speed” box to ‘0.45’. Notice that the contour lines around the visible
source (which is set to produce airborne pollution) move, while those around the hidden
source (which only leaches ground water) do not.
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2. Set the “Wind direction” box to ‘315’. Notice the change in the pollution contour lines
when the entry changes.
3. “Scale” is set to ‘5.0’ by default. This can be changed, but is fine as it is.
2.3.4

Creating a village

To add a sense of reality to the map, visible sources with zero strengths and radii can
be added to appear like a village. Add six visible sources with no pollution set at these
coordinates:
x
y
2.9 4.7
3.0 4.7
2.3.5

x
2.9
3.0

y
4.8
4.8

x
2.9
3.0

y
4.9
4.9

Sampling settings

The last thing to set is the limits on the sampling the students will perform. They will have
a limited number of samples, representing a limited time or limited budget. In this case,
they will be able to see the results immediately.
1. Set the “Samples allowed” box to 25.
2. Click on the “Results visible on click” tick box, and a mark should appear it to show
that it is set.
The last touch is to set the “Map title” box to something descriptive of the exercise. Set
it to ‘Fakeham, Cd, 25 visible’. Note that the title appears in the window title bar as you
type. Finally, save the map (use the “Save” option in the “File” menu) as “cd vis.map”.
This file can be loaded for further changes using the “Load” option in the “File” menu, or
loaded in PollutionSampler (see section 3).

2.4

Technical details

This section goes into detail describing the mathematics of the pollution distribution and
the contour lines. It is presented for interest, and is not necessary reading.
Both the hills and the ground water pollution obey Lorentzian distributions. Thus the
height a distance r away from a hill with height h0 and radius r0 is given by:
h(r) =

h0
1 + (r/r0 )2

(1)

Similarly, the equation for the pollution a distance r away from a ground source of strength
p0 and radius r0 is:
p0
(2)
p(r) =
1 + (r/r0 )2
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Airborne pollution is calculated in a different way. In the absence of wind, the pollution
from an airborne source of strength p0 with inner radius r0 and outer radius R0 is given by:
2r0
p0 r
2
R0 r0 + (r/R0 )2

(3)

This function is zero at the origin and tends to zero as r tends to infinity. It has a maximum
value of p0 when r = r0 R0 .
Wind affects the distribution of airborne pollution. If the prevailing wind is set to blow
on bearing θ with a windspeed of w then the pollution strength at the point (x, y) due to
an airborne pollution source of strength p0 located at (xc , yc ) is given by:
p0 (x, y) =

2r0
p0 r0 (w, x, y, θ)
R0 r02 + (r0 (w, x, y, θ)/R0 )2

(4)

where
r0 (w, x, y, θ) = (x − xc + rw sin θ)2 + (y − yc − rw cos θ)2

(5)

q

in which r = (x − xc )2 + (y − yc )2 .
The height at any point on the map is the sum of the contributions at that point from each
hill point. Similarly, the pollution at any point is the sum of the contributions from airborne
and ground water leached pollution from each pollution source. Approximate contour lines
are shown in the Map Display. It is computationally expensive to calculate a height for every
point on the screen, so JPollution uses a linear approximation. The map is divided up into
squares, each one twenty pixels on a side. Each square is then divided into two right angled
triangles. The pollution at each corner of each triangle is calculated, and a flat plane is
fitted. The contour lines that are drawn are the contour lines of this plane. This is why the
contour lines can appear and disappear as a point is moved around — a tight (small radius)
hill or pollution source might not be sampled by the contour line approximation.
Both the “Pollution at cursor” indicator and the sampling used by PollutionSampler use
the actual pollution at the point, not this linear approximation. Use the contour lines only
as a guide.
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Running PollutionSampler

This section is summarised for students as the Student’s Manual. It is recomended that you
distribute that to students in preference to this section.
You should have created a map (see section 2), or acquired one from somewhere. The
map files are small, and can be distributed by email or on a disk.
To start PollutionSampler under Windows and Mac OSX, as well as many UNIX graphical
environments you can simply double click the PollutionCreator.jar icon. From a command
line, change to the directory containing the .jar file and type ‘java -jar PollutionCreator.jar’.
A window titled “Pollution Sampler” should appear after a few seconds.
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3.1

Overview

The interface to PollutionSampler is similar to the interface to PollutionCreator. The large
black area on the left is the Map Display, and the remainder of the window is the Data Panel.
The area at the top of the Data Panel is the Map Data Panel, which displays information
about the loaded map. Below that is a button marked “Take sample”, and below that is the
Sample Data Panel.

3.2

Loading a map

A map can be loaded using the “Load map” option in the “File” menu. When a map is
loaded, the topographic contour lines and any visible sources appear in the Map Panel.
Hidden sources, hilltops, and the contour lines of pollution are not visible. The map settings
appear in the Map Data Panel.
• Title: The first line is the map title, which also appears in the title bar of the window.
• Results visible: This entry will read ‘Yes’ if the pollution at a sample is visible
immediately, and ‘No’ if the sample values will only be visible after all samples have
been taken.
• Scale: The length of each side of the map in kilometres.
• Wind speed: The speed of the prevailing wind in kilometres per hour.
• Wind direction: The compass bearing towards which the wind blows. North is
upwards.
• Samples: The number of samples taken, and the number allowed to be taken,

3.3

Taking samples

There are two steps to taking a sample. The first is to choose a site for the sample, and the
second is to take the sample. If at least one sample has not been taken, then clicking on
the Map Panel will cause a purple cross to appear at that point. No sample is taken. Click
somewhere else on the map and the purple cross will move to the point at which the mouse
was clicked.
To take a sample, click the “Take sample” button. If you have selected a point on the
map, then the purple cross turns yellow and a sample of the pollution at that point will be
taken. The number of the sample, the x and y positions (measured from the origin in the
top left corner of the Map Panel), and possibly the pollution strength at that location will
be added to the Sample Data Panel.
If the results should not be immediately visible, the pollution entry will be “--”. When
the last sample is taken, all of the dashes will be replaced with the pollution values. The
program does not simulate the process of lab analysis of samples.
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3.4

Saving the data

When all of the samples have been taken, it becomes possible to save the data. Use the
“Save” option in the “File” menu to choose the filename to save the data. Data is saved in
plain text in a file, with one entry per line. Each entry is the x coordinate, the y coordinate,
and the pollution strength, each separated by a tab character. Most spreadsheets can open
this type of file and understand it as a simple table.
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Suggested exercise

This is a simple exercise, probably best performed in groups of two or three. It is not really
intended for use, but more as an illustration of an application of JPollution.

4.1

Set up

For this exercise, you need the map whose creation is described in section 2.3. If you
did not create it, you can either do so now, or download it from the project website,
www.ibises.org.uk/JPollution. Save the map as ‘cd vis.map’.
1. Start PollutionCreator and load the map. De-select the “Results visible” box and save
the changed map as ‘cd not vis.map’. Export a copy of the map as a bitmap using
the “Export as BMP (no pollution)” option in the “File” menu, and one copy using
“Export as BMP (pollution)”.
2. Make sure that a JRE is installed on all the computers that the students are going to
use (see section 1.1.2).
3. Make sure that a version of PollutionSampler appropriate for the JRE version is installed in a place where the students can run it. A shared drive will work; alternatively,
they could download it from a website and run it from their user area.
4. Put the maps in a place where the students can access them (perhaps a website or a
shared drive).
5. Print a copy of the bitmap and the exercise and provide photocopies for each student
(and some extras...).
6. Photocopy the map onto acetate, one per group of students.
7. Print one copy of the map with the pollution marked onto acetate.
The students will be asked to use PollutionSampler to estimate the cadmium distribution
around the map, then present their results. Some will detect the small but strong zone of
pollution around the hidden source, some will not. After they have presented, explain that
the hidden source is a forgotten spoil heap (the smelter had to smelt something — there was
a mine there...). Lead into a discussion of the strengths and weaknesses of different sampling
methods.
11

4.2

The exercise

The village of Fakeham lies to the east of a small range of hills. The small village served a
smelter to the east of the town. Although the smelter is now disused, when it was operating
its main chimney used to produce smoke laden with cadmium. Cadmium is a heavy metal
that lingers in soil, and builds up in human tissue, where it has adverse effects.
In recent years, interest has risen in using the land to the north of Fakeham for agriculture.
However, there is some concern that there might be residual cadmium contamination. Your
company has been hired to assess the risk associated with this possible contamination.
(i) What are the legal levels of cadmium in soil that is to be used in agriculture?
In this exercise, you will be comparing several sampling strategies. The strategies you
will be investigating are:
• Directed sampling
• Grid sampling
• Random grid sampling
The instructor will assign a sampling strategy to your group. If you are assigned to directed
sampling then load the map ‘cd vis.map’; otherwise load the map ‘cd not vis.map’. See the
attached “Students’ Guide” for details of how to do this, and how to take samples. Note
that, due to time and budget constraints, you only have 25 samples with which to estimate
the pollution distribution.
Use the sampling strategy you have been assigned to take samples. Each group should
be issued with one acetate copy of the map of the area around Fakeham.
(ii) Draw approximate contour lines of the cadmium distribution on this map, using the
pens provided.
(iii) Mark the areas on the map where agriculture would be legal.
(iv) Is the village of Fakeham a safe place to live?
Your group will be asked to present your results in a five minute presentation at the end
of the session.
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